
To print (and preserve) these brochure 
instructions, choose Print from the File 
menu. Press Enter to print the brochure. 

HOW TO CREATE A 
BROCHURE 
Using this template, you can create a 
professional brochure. Here’s how: 

1.Insert your words in place of these 
words, using and/or re-arranging the 
preset paragraph Styles. 

2.Print pages 1 and 2 back-to-back onto 
sturdy, letter size paper. 

3.Fold the paper like a letter to create a 
three-fold brochure (positioning the panel 
with the large picture on the front). 

WHAT ELSE SHOULD I 
KNOW? 
To change the Style of any paragraph, 
select the text by positioning your cursor 
anywhere in the paragraph. With your 
cursor blinking in the paragraph, select a 
Style from the drop-down Style list at the 
top-left of your screen.  

To change the picture, first click on it. 
Then, point to Picture on the Insert menu 
and choose From File. Uncheck the Float 
over Text checkbox. Select a new picture, 
and click Insert.. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 

 

Travel Insurance that offers the ultimate 
peace of mind to protect your travel 
investment, and provides cash-less 

medical expense coverage. 

Never worry again about your 
travel plans. Purchase the 

TraveLeaders Travel Protection 
and feel secure.  

AXA ASSISTANCE 
122 South Michigan Avenue, Suite 1100 

Chicago, IL 60603 
Call 1-866-332-2731 Or 1-312-935-3719 

T r a v e L e a d e r s   
T r a v e l  P r o t e c t i o n  

COMPREHENSIVE QUALITY 
WORLDWIDE TRAVEL 

PROTECTION

What kind of travel benefits are there? 
BASIC COMPRHENSIVE PLAN BENEFITS 

BENFIT LIMITS: 
Trip Cancellation Up to Trip Cost 
Trip Interruption 150% Trip Cancellation Limit 
Travel Delay ($150/day) $500 after 6 hrs 
Missed Connection $300 
Loss of Baggage/Personal Effects $1000 
Baggage Delay $200 after 24 hrs 
Emergency Medical/Dental $50,000 
Emergency Medical Transportation $250,000 
24 hr Accidental Death & Dismemberment $10,000 
24 hr Assistance Included 
* Up to a maximum of $20,000 (for age 81 and over, 
maximum of $10,000) per person. Combined Total Cost of 
Trip cannot exceed $40,000 

BASIC POST DEPARTURE BENEFITS: 

Trip Interruption $1000 
Travel Delay ($150/day) $500 after 6 hrs 
Missed Connection $300 
Loss of Baggage/Personal Effects $1000 
Baggage Delay $200 after 24 hrs 
Medical/Dental Expense $50,000 
Medical Evacuation/Repatriation $250,000 
24 hr Accidental Death & Dismemberment $10,000 
24 hr Assistance Included 
  

DELUXE COMPRHENSIVE PLAN BENEFITS 

Trip Cancellation Up to Trip Cost 
Trip Interruption 150% Trip Cancellation Limit 
Travel Delay ($150/day) $1000 after 6 hrs 
Missed Connection $300 
Loss of Baggage/Personal Effects $1000 
Baggage Delay $300 after 24 hrs 
Emergency Medical/Dental $100,000 
Emergency Medical Transportation $300,000 
24 hr Accidental Death & Dismemberment $25,000 
24 hr Assistance Included 
* Up to a maximum of $20,000 (for age 81 and over, 
maximum of $10,000) per person. Combined Total Cost of 
Trip cannot exceed $40,000 

DELUXE POST DEPARTURE BENEFITS: 

Trip Interruption $1000 
Travel Delay ($150/day) $1000 after 6 hrs 
Missed Connection $300 
Loss of Baggage/Personal Effects $1000 
Baggage Delay $300 after 24 hrs 
Medical/Dental Expense $100,000 
Medical Evacuation/Repatriation $300,000 
24 hr Accidental Death & Dismemberment $10,000 
24 hr Assistance Included 
  

OPTIONAL BENEFITS 

Flight Accident Plan $100,000 
Flight Accident Plan 250,000 
 



HOW TO 
CUSTOMIZE 
THIS 
BROCHURE 
You’ll probably want to customize all your 
templates when you discover how editing 
and re-saving your templates would make 
creating future documents easier. To 
customize this brochure, select File New 
to re-open this template as a document. 

1.Insert your company information in 
place of the sample text. 

2.Choose Save As from the File menu. 
Choose Document Template in the Save 
as Type: box (the filename extensions 
should change from .doc to .dot). Save the 
file under a new name to protect the 
original, or use the same name to replace 
the existing version.  

3.To create a document, choose File 
New to re-open your template as a 
document. Your information should 
appear in place. 

ABOUT THE “PICTURES” 
The “pictures” in this brochure are 
Wingdings typeface symbols. To insert a 
new symbol, highlight the symbol 
character and choose Symbol from the 
Insert menu—select a new symbol from 
the map, click Insert, and Close. 

HOW TO WORK WITH 
BREAKS 
Breaks in a Word document appear as 
labeled dotted lines on the screen. Using the 
Break command, you can insert manual 
page breaks, column breaks, and section 
breaks. 

To insert a break, choose Break from 
the Insert menu. Select one option. Click 
on OK to accept your choice. 

HOW TO WORK WITH 
SPACING 
To reduce the spacing between, for 
example, body text paragraphs, click your 
cursor in this paragraph, and choose 
Paragraph from the Format menu. Reduce 
the Spacing After to 6 points, making 
additional adjustments as needed. 

To save your Style changes, (assuming 
your cursor is blinking in the changed 
paragraph), click on the Style in the drop-
down Style list at the top-left of your 
screen. Press Enter to save the changes, 
and update all similar Styles. 

To adjust character spacing, select the text 
to be modified, and choose Font from the 
Format menu. Click Character Spacing 
and enter a new value. 

OTHER BROCHURE TIPS 
To change a font size, choose Font from 
the Format menu. Adjust the size as 
needed, and click OK or Cancel to exit. 

To change the shading of shaded 
paragraphs, choose Borders and Shading 
from the Format menu. Select a new shade 
or pattern, and choose OK. Experiment to 
achieve the best shade for your printer. 

To remove a character style, select the 
text and press Ctrl-Spacebar.  You can also 
choose Default Paragraph Font from the 
Style drop-down. 

BROCHURE IDEAS  
“Picture” fonts, like Wingdings, are gaining 
popularity. Consider using other symbol 
fonts to create highly customized “Icons.” 

Consider printing your brochure on 
colorful, preprinted brochure paper—
available from many paper suppliers. 

AT FEES YOU CAN AFFORD 
We can often save you more than the cost 
of our service alone. So why not subscribe 
today?  

Call 555-0000 

 

 

 

 

 

 

TraveLeaders Travel Protection is committed to protecting 
all aspects of your trip. We have worked very hard to 
become one of the industry leaders in travel protection and 
offer competitive pricing, comprehensive trip protection and 
an outstanding reputation for service.  

TraveLeaders Travel Protection consists of the finest travel 
protection benefits, which protect you from unexpected 
occurrences that can happen around the world or around 
the corner 

Why Purchase Travel Protection? 

� You, your family, domestic partner or even your travel 
companions become sick or injured and this prevents 
you from traveling. 

� You arrive at your destination and your luggage is lost 
or damaged. 

� Your plane is delayed and you end up paying 
additional expenses. 

� You become ill or injured abroad and need medical 
assistance. 

� You are injured during your trip and need to be 

What’s included in the Travel 
Protection? (Cont’d) 

Cash-less Medical Expenses: 
With TraveLeaders Travel Protection, your medical 
expenses are paid up front, without need of disbursement. 
In the event that a hospital does not recognize your 
medical insurance, or if   you are outside your country of 
residence, TraveLeaders Travel Protection   will guarantee 
your hospital admission for you or your dependents by 
validating your health coverage and paying up front your 
medical expenses. Benefits will be up to the maximum 
described in the schedule of benefits per person, per trip, 
for eligible medical expenses if you become ill or injured 
during the trip. 

Bankruptcy and Default Protection: If You purchase 
TraveLeaders Travel Protection within ten (10) days of 
Your initial Trip payment and for the full non-refundable 
cost of Your Trip, You will be eligible for benefits up to a 
maximum limit of $20,000 or the benefit amount protected, 
whichever is less, due to the Bankruptcy or Default of an 
airline, cruise line, or tour operator (other than the travel 
agent or Travel Supplier that solicited this Protection Plan 
and from whom You purchased Your Travel Arrangements) 
which stops service more than fourteen (14) days following 
Your Protection Plan Effective Date. Your scheduled 
Departure Date must be no more than fifteen (15) months 
beyond the Effective Date of Your Protection Plan. Benefits 
will be paid due to Bankruptcy or Default of an airline only if 
no alternate transportation is available. If alternate 
transportation is available, benefits will be limited to the 
change fee charged to allow You to transfer to another 
airline in order to get to Your intended destination. 

The Bankruptcy or Default benefit is excess and secondary 
to all other forms of indemnity. 

Terrorism Protection: If You purchase TraveLeaders 
Travel Protection within ten (10) days of Your initial Trip 
payment and for the full non-refundable cost of Your Trip, 
You will be eligible for benefits up to Your protected Trip 
cost if You cancel Your Trip due to a Terrorist Incident. The 
Terrorist Incident must occur in a city listed on Your 
itinerary within 30 days prior to Your Scheduled Departure 
Date. This same city must not have experienced a Terrorist 
Incident within the 90 days prior to the Terrorist Incident 
which is causing Your cancellation. Benefits are not 
provided if Your Travel Supplier offers a substitute itinerary. 

The Double Advantage: You may cancel the Protection 
Plan by giving us written notice within either 20 days from 
the date of issuance of Your Protection Plan, or Your 
Departure Date whichever occurs first. If You do this, we 
will refund Your plan cost in full (excluding the 
administration fee). 

Description of Travel Protection 
Benefits 

TRIP CANCELLATION 
 

You are eligible for benefits up to the amount protected for 
unused nonrefundable prepaid expenses for Travel 
Arrangements whenever You are prevented from taking a 
Trip for any of the following reasons that occur after the 
Effective Date of Your Protection Plan: 
� Sickness, Injury or death involving You or Your 

Traveling Companion or Your Business Partner or 
Family Member of either You or Your Traveling 
Companion which results in medically imposed 
restrictions as certified by a Legally Qualified 
Physician at the time of loss preventing Your 
continued participation in the Trip; 

� Unannounced Strike which causes complete 
cessation of services of Your Common Carrier for at 
least 48 consecutive hours; 

� Weather which causes complete cessation of services 
of Your Common Carrier for at least 48 consecutive 
hours; 

� Employer Termination or layoff affecting You or a 
person(s) sharing the same room during Your Trip. 
Employment must have been with the same employer 
for at least 3 continuous years; 

� Primary Residence of You or Your Traveling 
Companion is rendered uninhabitable by unforeseen 
circumstances; 

� Burglary of You or Your Traveling Companion’s 
Primary Residence within 10 days of departure or 
during Your Trip; 

�  Felonious Assault of  You or Your Traveling 
Companion within 10 days of departure or during Your 
Trip; 

 If You purchase TraveLeaders Travel Protection within ten 
(10) days of Your initial Trip payment and for the full non-
refundable cost* of Your Trip, You will be eligible for 
benefits up to a maximum limit of $20,000 or the benefit 
amount protected, whichever is less, due to the Bankruptcy 
or Default of an airline, cruise line, or tour operator (other 
than the travel agent or Travel Supplier that solicited this 
Protection Plan and from whom You purchased Your 
Travel Arrangements) which stops service more than 
fourteen (14) days following Your Protection Plan Effective 
Date. Your scheduled Departure Date must be no more 
than fifteen (15) months beyond the Effective Date of Your 
Protection Plan. Benefits will be paid due to Bankruptcy or 
Default of an airline only if no alternate transportation is 
available. If alternate transportation is available, benefits 
will be limited to the change fee charged to allow You to 
transfer to another airline in order to get to Your intended 
destination. The Bankruptcy or Default benefit is excess 
and secondary to all other forms of indemnity. *For the 
Post-Departure Plan You must protect the full length of 
Your Trip;  

What’s included in the Travel 
Protection? 

Pre-Existing Condition Waiver: The Pre-Existing 
Condition exclusion is waived provided You purchase 
TraveLeaders Travel Protection within ten (10) days of 
Your initial Trip payment; protect the full non-refundable 
cost of Your Trip; are medically able to travel on the date 
You purchase TraveLeaders Travel Protection and have 
not filed a Trip Cancellation claim due to a Pre-Existing 
Condition within 180 days prior to the Effective Date of 
Your Protection Plan. 

 



 
MEDICAL EXPENSE 

With TraveLeaders Travel Protection, your medical 
expenses are paid up front, without need of disbursement. 
In the event that a hospital does not recognize your 
medical insurance, or if   you are outside your country of 
residence, TraveLeaders Travel Protection   will guarantee 
your hospital admission for you or your dependents by 
validating your health coverage and paying up front your 
medical expenses. Benefits will be up to the maximum 
described in the schedule of benefits per person, per trip, 
for eligible medical expenses if you become ill or injured 
during the trip. 
You are eligible for benefits up to the benefit amount shown 
for: Eligible Medical Expenses incurred during Your trip as 
a result of an Injury which occurs or Sickness which first 
manifests itself during the Trip. Benefits will include 
expenses for emergency dental treatment not to exceed 
$750. Advance payment will be made to a Hospital, subject 
to the applicable benefit amount if needed to secure Your 
admission to a Hospital because of Sickness or Injury 
which first occurs during the course of the Trip. The 
authorized Assistance Company will coordinate advance 
payment to the Hospital. In all cases, benefits will not be 
paid in excess of the Usual and Customary Charges. 

MEDICAL EVACUATION / REPATRIATION 

You are eligible for benefits up to the benefit amount shown 
for: 1) Medical Evacuation which is determined by a Legally 
Qualified Physician and the authorized Assistance 
Company’s medical director when Injury or Sickness is 
acute or life threatening and adequate treatment is not 
available at a local Hospital. Transportation will be provided 
to the closest Hospital or medical facility capable of 
providing adequate treatment; 2) Medical Repatriation is 
provided when it is deemed Medically Necessary by a 
Legally Qualified Physician and the authorized Assistance 
Company for You to return to Your home or a Hospital near 
Your home for continued treatment. Transportation 
Expense incurred will be paid for You via one-way 
Economy Transportation; or commercial upgrade, based on 
Your condition as recommended by the local attending 
Legally Qualified Physician and the authorized Assistance 
Company: a) to return to Your permanent residence or b) to 
be moved to a Hospital or medical facility closest to Your 
permanent place of residence capable of providing that 
treatment; 3) Either: a) transportation will be provided for 
the return trip home via Economy Transportation for any 
dependent children under 18 who are accompanying You if 
You are confined to a Hospital for more than 7 consecutive 
days; or b) if You are traveling alone and are confined to a 
Hospital for more than 7 consecutive days, this benefit will 
provide one round-trip Economy Transportation for a 
person of Your choice to visit You in a Hospital. These 
benefits provide the most appropriate and Economical 
Transportation by the most direct and economical route. 
This benefit for land or air transportation includes, but is not 
limited to, commercial stretcher, medical escort, or the 
Usual and Customary Charges for air ambulance, provided 
such transportation has been pre-approved and arranged 
by the authorized Assistance Company. Benefits are 
calculated less the value of an unused return travel ticket. 

TRAVEL DELAY 

You are eligible for benefits up to the benefit amount shown 
for: a) Additional Transportation Cost to join the Trip or 
return home, including up to $150 per day, up to the 
maximum benefit limit, for reasonable accommodations 
and meals, if Your delay requires an unplanned overnight 
stay; or b) unused nonrefundable portion of the prepaid 
expenses as long as the expenses are supported by proof 
of purchase and are not reimbursable by any other source. 
Delay must be for 6 hours or more and certified due to one 
of the following reasons: 1) Delay of Common Carrier 
(which is certified by the Common Carrier); 2) A traffic 
accident in which You were not directly involved 
(substantiated by a police report); 3) Documented weather 
condition preventing You from getting to the point of 
departure; 4) Quarantine, hijacking, Strike, natural disaster, 
terrorism or riot; 5) Lost or stolen passports, travel 
documents or money (must be substantiated by a report to 
the police or the appropriate authority). 

MISSED CONNECTION 

Provides benefits up to the benefit amount shown for: 1) 
Additional Transportation Cost to join the cruise or tour; 2) 
Accommodation and hotel expenses, if You miss Your 
cruise or tour departures because Your airline flight was 
cancelled or delayed for at least 3 hours due to one of the 
following reasons: 1) Delay of Common Carrier (which is 
certified by the Common Carrier); or 2) Documented 
weather conditions. 

BAGGAGE & PERSONAL EFFECTS 

You are eligible for benefits up to the benefit amount shown 
for lost, stolen, or damaged baggage or personal items 
subject to a maximum reimbursement of up to $250 per 
article. The lesser of the following amounts will be paid: i) 
the actual cash value (cost less proper deduction for 
depreciation) at the time of loss, theft or damage; ii) the 
cost to repair or replace the article with material of a like 
kind and quality. A maximum of $500 applies to the total 
amount payable for loss of any or all of the following: 
jewelry, watches, articles consisting in whole or in part of 
silver, gold or platinum, articles trimmed with fur, cameras 
and their accessories and related equipment. In addition, 
the following reimbursements are included in this benefit: 1) 
Lost or stolen passport or visa ($50 maximum); 2) Lost or 
stolen credit cards (cost associated with the unauthorized 
use – $50 maximum subject to verification that You have 
complied with all conditions of the credit card company). 

BAGGAGE DELAY 

If Your checked baggage is delayed or misdirected while 
on Your Trip for more than 24 hours from Your time of 
arrival at Your destination other than Your residence by a 
Common Carrier, You are eligible for benefits up to the 
benefit amount shown for the expense of necessary 
purchases of personal items as long as the expense is 
substantiated by receipts for purchases. The Common 
Carrier must certify the delay. 

 

TRIP CANCELATION (CONT’D) 

� If You purchase TraveLeaders Travel Protection within 
(10) days of Your initial Trip payment and for the full 
non-refundable cost of Your Trip, You will be eligible 
for benefits up to Your protected Trip cost if You 
cancel Your Trip due to a Terrorist Incident. The 
Terrorist Incident must occur in a city listed on your 
itinerary within 30 days prior to Your Scheduled 
Departure Date. This same city must not have 
experienced a Terrorist Incident within the 90 days 
prior to the Terrorist Incident, which is causing your 
cancellation. Benefits are not provided if Your Travel 
Supplier offers a substitute itinerary;  

� Hijack, quarantine, jury duty, or court ordered 
appearance as a witness in a legal action in which 
You or Your Traveling Companion is not a party 
(except law enforcement officers); 

� You or Your Traveling Companion are called to 
emergency military duty for a national disaster other 
than war; 

� Traffic accident, substantiated by a police report, 
directly involving either You or a Traveling Companion 
while en route to a scheduled departure point; 

� Your family or friends living abroad with whom You 
were planning to stay, are unable to accommodate 
You due to life threatening ill ness, life threatening 
injury or death of one of them; 

� If Your Travel Supplier cancels Your Trip, You are 
eligible for benefits equal to the amount protected for 
your airline tickets or the value of the reissue fee. You 
must have protected the entire cost of Your Trip 
including the airfare. (Does not apply to Post 
Departure Plan). All cancellations must be reported to 
the Travel Supplier within 72 hours of the event 
causing the need to cancel. If the event delays the 
reporting of the cancellation beyond the 72 hours, 
report the event as soon as possible. All other delays 
of reporting beyond 72 hours will result in reduced 
benefit payments. 

TRIP INTERRUPTION  
(POST DEPARTURE PLAN – RETURN AIR ONLY) 

If you are prevented from completing a Trip for any of the 
reasons listed under the Trip Cancellation section that 
occur after Your Protection Plan Effective Date and after 
the departure date of the Trip, You are eligible up to the 
benefit amount protected for: 

� Any unused prepaid expenses for Travel 
Arrangements; 

�  Return air: One way Economy Transportation to 
return to Your original destination or rejoin Your 
Trip less the value of the original unused return 
travel ticket;  

Single supplement upgrade –You are eligible for benefits 
when Your Traveling Companion cancels or interrupts a trip 
for a specified reason and you do not. 



 

 

 

 

 

 

 

 

 

 

MEDICAL EVACUATION / REPATRIATION (CONT’D) 

If benefits are payable under Your Protection Plan and You 
have other insurance that may provide benefits for this 
same loss, we reserve the right to recover from such other 
insurance. Note, Pre-Existing Condition limitation is 
automatically waived for the Medical Evacuation / 
Repatriation Benefit. 

ACCIDENTAL DEATH AND DISMEMBERMENT 

You are eligible for benefits 24 hours a day, up to the 
benefit amount shown, when You sustain Injuries resulting 
in any of the listed Type of Loss, within 180 days from the 
date of accident, while on a Trip.  

OPTIONAL FLIGHT ACCIDENT 

These benefits apply up to the amount purchased for 
accidental death, dismemberment or loss of sight as a 
result of an accident while a passenger on a regularly 
scheduled air flight, a land or water conveyance provided 
by the airline as a substitute for an aircraft, a Common 
Carrier while en route to or from the airport, or at the airport 
immediately before boarding or after disembarking from an 
aircraft. 

TRAVEL ASSISTANCE SERVICES 

The Travel Assistance feature provides a variety of travel 
related services. Services offered include: Medical 
evacuation • Medically necessary repatriation • Repatriation 
of remains • Medical or legal referral • Hospital admission 
guarantee • Translation service • Lost Baggage retrieval • 
Inoculation information • Passport / visa information • 
Emergency cash advance* • Prescription drug / eyeglass 
replacement* • Bail bond*  

* Payment reimbursement to the Assistance Company is your 
responsibility. 

Travel assistance services are provided by an independent 
organization and not by TIG Premier Insurance Company, 
Ranger Insurance Company; TIG Insurance Company or 
Travel Insured International. There may be times when 
circumstances beyond the Assistance Company’s control 
hinder their endeavors to provide travel assistance 
services. They will, however, make all reasonable efforts to 
provide travel assistance services and help you resolve 
your emergency situation. 

WHEN YOUR BENEFITS APPLY 

The “Effective Date” of Your Protection Plan begins at 
12:01 a.m. following the postmark of Your application, or 
12:01 a.m. following the date You apply by phone or fax 
and pay the proper amount. Trip Cancellation Benefit and 
Assistance Services begin on the Effective Date. Travel 
Delay Benefit is in force while You are en route to and from 
Your Trip.  All Other Benefits begin on 12:01 a.m. on Your 
Scheduled Departure Date or Your Protection Plan 
Effective Date, whichever is later. Benefits end when You 
cancel Your Trip, when You return home, or when You 
complete the term of Your Trip. 

WHEN BENEFITS ARE NOT PAYABLE UNDER THIS 
PLAN 

Unless otherwise stated, benefits are not payable for 
Sickness, Injuries or losses of You or Your Traveling 
Companion 1) Resulting from suicide, attempted suicide, or 
any intentionally self-inflicted injury while sane or insane (in 
Missouri, sane only); 2) Resulting from an act of declared 
or undeclared war or occurring while participating in 
maneuvers or training exercise of an armed service; 3) 
Occurring while or resulting from riding, driving or 
participating in races, or speed or endurance contests; 4) 
Occurring while or resulting from mountaineering (engaging 
in the sport of scaling mountains generally requiring the 
use of picks, ropes or other special equipment); 5) 
Occurring while or resulting from participating as a member 
of a team in an organized sporting competition; 6) 
Occurring while or resulting from participating in skydiving, 
hang gliding, bungee cord jumping, scuba diving or deep 
sea diving; 7) Occurring while or resulting from piloting or 
learning to pilot or acting as a member of the crew of any 
aircraft; 8) Received as a result or consequence of being 
Intoxicated or under the influence of any controlled 
substance unless administered on the advice of a Legally 
Qualified Physician; 9) To which a contributory cause was 
the commission of or attempt to commit a felony or being 
engaged in an illegal occupation; 10) Due to normal 
childbirth, normal pregnancy (except complications of 
pregnancy) or voluntarily induced abortion; 11) Due to 
dental treatment (except as otherwise specifically provided 
herein); 12) Due to a Pre-Existing Condition. This exclusion 
is waived if; You purchase Your Protection Plan within 10 
days of Your initial Trip payment; for the full non-refundable 
cost of Your Trip; and You are medically able to travel 
when You pay for Your Protection Plan; and You have not 
filed a Trip Cancellation claim due to a Pre-Existing 
Condition within 180 days prior to the effective date of Your 
Protection Plan. Note: Pre- Existing condition limitation is 
automatically waived for Medical Evacuation/ Repatriation 
benefits; 13) Due to a Mental or Nervous Condition unless 
hospitalized.  

WHAT IS NOT PAYABLE UNDER BAGGAGE/ 
PERSONAL EFFECT OR BAGGAGE DELAY BENEFIT 

Benefits are not payable for loss of any of the following: a) 
animals, b) automobile or automobile equipment, boats or 
other vehicles or conveyances, trailers, motors, aircraft, 
bicycles (except when checked as baggage with a 
Common Carrier); c) household effects and furnishings, 
antiques or collectors items; d) sunglasses (prescription or 
non-prescription) or contact lenses; e) artificial teeth or 
dental bridges; f) hearing aids; g) prosthetic limbs; h) 
prescribed medications; i) keys; j) money, credit cards, 
tickets, documents (except as otherwise specified under 
the benefit description) or securities; k) stamps; l) 
professional or occupational equipment or property 
(whether or not electronic business equipment), telephones 
or computer hardware or software. 

 PLAN DEFINITIONS 
“Bankruptcy” means the filing of a petition for voluntary or 
involuntary bankruptcy in a court of competent jurisdiction under 
Chapter 7 or Chapter 11 of the United States Bankruptcy Code 11 
U.S.C. 101 et seq.  

 “Common Carrier” means any public land, air or water 
conveyance operating under a valid license providing for the 
transportation of passengers for hire.  

“Default” means the inability to provide contracted services due to 
a financial failure. “Domestic Partner” means a person who is at 
least eighteen years of age and You can show: 1) evidence of 
financial interdependence, such as joint bank accounts or credit 
cards, jointly owned property, and mutual life insurance or pension 
beneficiary designations; 2) evidence of continuous cohabitation 
throughout the 180 day period prior to the Effective Date of Your 
Plan; and 3) an affidavit of domestic partnership if recognized by the 
jurisdiction within which they reside.  

“Family Member” means any of the following who resides in the 
United States, Canada, or Mexico: You or Your Traveling 
Companion’s: legal spouse (or common-law spouse where legal), 
legal guardian, son or daughter (adopted, foster, step or in-law), 
brother or sister (includes step or in-law), parent (includes step or 
in-law), grandparent (includes in-law), grandchild, aunt, uncle, niece 
or nephew. Domestic Partner, a caregiver who lives with and is 
employed by You, or a person for whom You are the primary 
caregiver with whom You have lived for 12 continuous months prior 
to the effective date of Your plan, whether or not they travel with 
You.  

 “Pre-Existing Condition” means any Injury, Sickness or condition 
(including any condition from which death ensues) of You, or Your 
Traveling Companion, You or Your Traveling Companion’s Family 
Member or Your Business Partner which within the one hundred 
and eighty (180) day period prior to the Effective Date of Your 
Protection Plan: a) manifested itself, became acute or exhibited 
symptoms which would have caused one to seek diagnosis, care or 
treatment; b) required taking prescribed drugs or medicine, unless 
the condition for which the prescribed drug or medicine is taken 
remains controlled without any change in the required prescription; 
or c) required medical treatment or treatment was recommended by 
a Legally Qualified Physician. (Note, In California, part “a” is not 
applicable).  

“Scheduled Departure Date” means the date on which You are 
originally scheduled to leave on Your Trip.  

“Scheduled Return Date” means the date on which You are 
originally scheduled to return to the point of origin or the original 
final destination.  

 “Travel Arrangements” mean: a) transportation; b) 
accommodations; and c) other specified services arranged by the 
Travel Supplier for the Trip.  

“Traveling Companion” means a person or persons with whom 
You; a) have coordinated Travel Arrangements; and b) intend to 
travel with during the Trip. Note: a group or tour leader is not 
considered a Traveling Companion unless You are sharing room 
accommodations with the group or tour leader.  

 “Trip” means scheduled trips, tours or cruises for which: a) 
benefits are requested; and b) the required plan cost is submitted 
prior to the Scheduled Departure Date.   

“You” or “Your” means the individual named on the enrollment 
form who has purchased a Trip and for whom the required cost for 
the Protection Plan has been paid.  

Products underwritten by TIG Premier Insurance Company and 
Ranger Insurance Company under the management of Fairmont 
Specialty Group. In addition, TIG Insurance Company, affiliated with 
TIG Specialty will be used in select states. 



GOLD  
Comprehensive Protection Plan Rates 

 Age of Traveler 

Tour Cost 0-40 41-55 56-70 71-80 81+ 
$0-$500 $35 $42 $57 $97 $158 

$501-$1000 $48 $72 $91 $135 $223 
$1001-$1500 $63 $91 $111 $175 $293 
$1501-$2000 $80 $124 $143 $219 $373 
$2000-$2500 $109 $156 $187 $279 $552 
$2501-$3000 $137 $187 $229 $345 $716 
$3001-$3500 $177 $213 $272 $409 $829 
$3501-$4000 $197 $241 $331 $482 $963 
$4001-$4500 $224 $276 $384 $560 $1089 
$4501-$5000 $251 $310 $437 $627 $1215 
$5001-$5500 $319 $363 $494 $809 $1457 
$5501-$6000 $349 $398 $572 $888 $1596 
$6001-$6500 $380 $433 $650 $963 $1736 
$6501-$7000 $415 $472 $710 $1055 $1896 
$7001-$8000 $457 $520 $797 $1158 $2142 
$8001-$9000 $514 $586 $901 $1306 $2418 

$9001-$10000 $576 $655 $1007 $1460 $2705 
$10001-$20000* 6.97% 7.66% 11.16% 15.77% N/A 

*Rates are percent of tour cost 

GOLD 
Post Departure Protection Plan Rates 

 Age of Traveler 

Trip Length 0-40 41-55 56-70 71-80 81+ 
1-4 Days $11 $14 $25 $30 $53 
5-8 Days $23 $29 $48 $59 $103 

9-15 Days $38 $48 $79 $101 $171 
16-23 Days $60 $74 $122 $159 $263 
24-30 Days $90 $108 $179 $256 $378 

* Maximum number of days for any one trip is 30 Days. 
  Charge of $8 per day is added to trips over 30 days 

GOLD 
Optional Add-On Coverages 

Flight Accident Plan - $100,000 $13 

Flight Accident Plan - $250,000 $25 

 APPLICATION 

Please make sure to complete the entire application 
and to print clearly the names and birthdates of all 
travelers. 

TRIP INFORMATION 

Agency Acct #  

Departure Date  

Destination  

Return Date  

Trip Deposit 
Date

 

Tour/Cruiseline  

Beneficiary  

PURCHASER INFORMATION 

Name  

Address  

City  

State  Zip  

Date of Birth  

Phone #  

You Must be a US Citizen or Resident to Purchase 

FAMILY MEMBERS TRAVELING WITH YOU 

List only the Family Member traveling with you whom you 
are purchasing travel protection. 

 NAME  D.O.B. 

#2    

#3    

#4    

#5    

 

Basic Comprehensive Protection Plan Rates 

 Age of Traveler 

Tour Cost 0-40 41-55 56-70 71-80 81+ 
$0-$500 $29 $34 $52 $75 $123 

$501-$1000 $39 $49 $73 $105 $172 
$1001-$1500 $52 $61 $94 $135 $227 
$1501-$2000 $66 $83 $126 $170 $289 
$2000-$2500 $90 $105 $158 $242 $427 
$2501-$3000 $111 $126 $189 $292 $553 
$3001-$3500 $126 $147 $232 $342 $641 
$3501-$4000 $140 $164 $258 $398 $745 
$4001-$4500 $152 $182 $302 $458 $842 
$4501-$5000 $168 $211 $348 $515 $940 
$5001-$5500 $215 $249 $452 $626 $1127 
$5501-$6000 $238 $275 $506 $687 $1235 
$6001-$6500 $262 $302 $549 $746 $1342 
$6501-$7000 $278 $322 $603 $816 $1467 
$7001-$8000 $311 $359 $646 $896 $1657 
$8001-$9000 $355 $410 $743 $1010 $1871 

$9001-$10000 $402 $464 $840 $1130 $2092 
$10001-$20000* 5.39% 5.93% 8.63% 12.20% N/A 

*Rates are percent of tour cost 

Basic Post Departure Protection Plan Rates 

 Age of Traveler 

Trip Length 0-40 41-55 56-70 71-80 81+ 
1-4 Days $8 $11 $19 $23 $41 
5-8 Days $18 $22 $37 $46 $79 

9-15 Days $30 $37 $64 $78 $132 
16-23 Days $47 $57 $94 $123 $203 
24-30 Days $70 $84 $139 $198 $292 

* Maximum number of days for any one trip is 30 Days. 
  Charge of $4 per day is added to trips over 30 days 

Basic Optional Add-On Coverages 

Flight Accident Plan - $100,000 $10 

Flight Accident Plan - $250,000 $21 
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APPLICATION (Cont’d) 

Please make sure to complete the entire application 
and to print clearly the names and birthdates of all 
travelers. 

CALCULATE PRICING 

Please note: We recommend that you protect the full non-
refundable cost of your trip 
 Fill in Trip Cost Per 

Person 
Select & Fill in the 

plan rate per person 
Purchaser   

#2   

#3   

#4   

#5   

Calculate additional cost for trips over 30 days 

# of days over 30____* (# of travelers) ____*$.4.0=$_____ 

Non-Refundable Administration fee (per applicant): $7.00 

Total for this section $ 

OPTIONAL FLIGHT ACCIDENT PLAN 

Optional Flight Accident Plan may only be purchased when 
combined with the purchase of your plan & must apply to all 
travelers 

  $100,000 - $10 /person    $250,000 – $21 /person  

Plan Rate ____* (# of travelers) ____ =$_____ 

Non-Refundable Administration fee (per applicant): $7.00 

Total for this section $ 

INDICATE PAYMENT METHOD 

 

 

 

 

 

 

Expiration 
Date (MM/YY) 

 

Name on 
Credit Card 

 

Credit Card 
Number 

 

Signature  


